
Introduction to Excel
Excel is a spreadsheet application developed by Microsoft. It is used to store, organize and analyze data. It 

facilitates the use of calculations, graphing tools, pivot tables, and macro programming languages (which are called 

visual basics) etc. Excel is part of Microsoft Office.

Excel is a spreadsheet program created in certian blocks, with the help of which one can keep and view various 

data in a tabular form. One of the special features of Excel is that, it also allows the user to perform different types of 

calculations automatically. It is Windows-based software that has a very large spreadsheet. Each block in this 

spreadsheet inputs data and can perform all the functions of DOS based software Lotus. It is easily operated through 

mouse and formatting can be done as per the need. Since Excel is part of Microsoft office, the data used in this 

software can be imported or exported with MS Access, MS power point and MS Word software, as per the 

requirement. A worksheet appears on the screen after loading the Excel Software.

Every file in Excel is known as a workbook. There can be many worksheets in a workbook. A worksheet is 

divided into rows and columns. Each column is displayed with in alphabet, whereas rows are in numbers. The 

intersection between a row and a column on a spreadsheet is termed as cell. The identification of a cell is done by the 

numbers and letters for rows and columns respectively. If the row is numbered as 5 and E represents column, the cell 

will be identified as E5.  A cell starts with A1. Text, number or mathematical formula can be inserted in a cell.

A worksheet is located just above the status bar and can be entered by making a click on it. By default, three 

worksheets are already created in Excel. Select /Insert Worksheet can be followed to create a new worksheet. Inorder 

to change the name of the worksheet that is to rename a sheet, simply right-click on the name of the sheet that you 

wish to rename. Its major elements and actions have been explained further in the chapter. In MS excel, the user will 

see a screen displayed in Picture : This screen is known as the basic user interface. 

Application of Electronic Spreadsheet in Accounting
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Learning objectives :
After studying this Chapter, you will :

 Know about the utility of Spread Sheet

 Know the features of  Microsoft Excel

 Understand Spreadsheet sources and use them in Accounting.

 Perform financial analysis through Spreadsheets.

 Understand the elements of Excel Spreadsheets.

· Know the difference between Spreadsheet and Workbook
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Picture 1: Basic User Interface
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1.  Backstage view

Office Backstage View offers options for sharing, opening and printing the document. After clicking on the File 

tab, the backstage view of Microsoft Excel can be seen. In this, the file gives the options to save, open, print, etc., 

through the menu. Various types of instructions related to the file are explained below:

New-  To create a new workbook, select File / New in the menu bar or press (CTRL+N) keys or click the New 

button in the toolbar.

Open - To open a workbook already created, select File / Open in the menu bar or press (CTRL+O) keys or click 

on Open button in the toolbar.

Save - To save a workbook, select File / Save in the menu bar or press (CTRL+S) keys or click the Save button in 

the toolbar.

Print - To print a spreadsheet, select File / print in the menu bar or press (CTRL+P) keys or click the print button 

in the toolbar.

Print Preview - To see a workbook before printing, select File / Print Preview in the menu bar or click on the 

button before printing button.

Undo, Redo - Undo - Reverses the last command, use pull-down menu to undo several steps. Redo - Reverses 

the action of the Undo button, use the pull-down menu to redo several steps. 

Inserting hyperlink - To insert a hyperlink, type the text in a field and click the hyperlink button and enter the 

address of the website to give hyperlink.

Zoom - Click the zoom button in the toolbar to zoom in to a workbook i.e. big or small.
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Picture 2 : Excel Backstage View

2. Importance and use of Excel Spreadsheet

This is very simple and fast working software. It has many uses in business and profession. It can be made on a single 

sheet (spreadsheet). It can be used to make mathematical properties instantly of all kinds of digits and figures. By 

using several types of formulae various calculations can be done and saved as per requirement. After saving these 

threads, you can use and process the data several times. 

Spread Sheet is known as a program. It can be used in a business for the following purposes :

(i) Inventory Management: It can be used for managing and controlling the stock of a business. The purchase, 

issue and valuation of the stock can be processed through spreadsheet.

(ii) Calculation of working time: Data can be stored in spread sheet. Time taken to complete a task can be 

calculated through spread sheet. Just like a ten minute time is taken by a laborer to manufacture a single unit, 

in this situation how much time will it take to produce five hundred units, it can be calculated faster by the 

spreadsheet. Similarly, the salary given to laborers and employees can be also calculated with the use of 

Excel.

(iii) Accounting and Excel: Accounting of a Income and expenditure can be maintained using Excel. Sales and 

income related expenses are inserted in cells. Thereafter with the application of formulae or commands net 

profit or loss can be calculated. Profit or loss in future can be also predicted. It can also be used to prepare 

budget. The budget can be made on the same spreadsheet for more than one units of production or sale.

(iv) Format of Bill: The format of the bill or invoice can be produced using spreadsheet. In bill, the description, 

type, quantity per item of goods can be inserted through the columns and rows. The bill of purchase and sale 

can be sent by email. 

(v) Description of Clients: The most important person in a business is customer. Details of customers can be kept 

in Excel. It can provide information about the business projects and proposals to the customers. Customers 

Names, Addresses, and Mobile numbers can be store. Similarly, the details of customers who purchased 

goods on credit can be also kept, so that total debtors can be calculated.
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3. Structure of Workbook and Spreadsheet

An Excel document is composed of multiple worksheets and charts, which is also called workbook. A 

workbook is a file containing spreadsheets and charts. In a workbook we can keep many spreadsheets related to one 

type or one task. When you follow the steps outlined above to open Microsoft Excel, a workbook opens, which 

includes three worksheets by default. The main and largest part of the Excel screen is a spreadsheet that looks like a 

graph paper. Although the spreadsheet is very large in size and the entire spreadsheet does not appear on the screen 

at the same time, but its upper left part is shown on the screen from which we can start feeding our data. Each small 

block of a spreadsheet is called cell. This can be formatted according to the size and type of our data.

An Excel spreadsheet is a matrix of rows and columns .This is a type of sheet, which has vertical and horizontal 

parallel lines, which form a rectangular grid, termed as Cell in which the data is placed. We can also use the formula in 

this cell. More than three worksheets can be inserted as per the requirement. To add additional worksheets, the 

shortcut key combination (Shift+F1) can be utilized. A worksheet contains a total of 1,048,575 rows and 16,384 

columns. For example, the address of the leftmost cell at the top shown in the picture is A1. Where A is column and 1 is 

row.

Picture 3 :  Worksheet

The structure of a workbook can be understood by the following points.

(i) Sheet 1, sheet 2, and sheet 3 are displayed on the bottom of the workbook. These three sheets are different 

sheets on which work can be done simultaneously. To add a new worksheet, click on the tab after the sheet 3 . 

You can change the name of the worksheet by clicking on it and selecting Rename option as displayed in the 

picture.

(ii) For a particular cell selection ,click on the cell to select the cell, keep your cursor from the first cell A1.The 

address of the cell will be displayed in the name box and the content of the cell will be on  formula bar. The 

address of the cell changes as it moves around in a sheet. You can easily move from one cell to another by 

pressing the tab or using the arrow keys.

(iii) Clicking on your mouse button allows more than one cell to be selected at a time and the selected cells are 

highlighted. In Microsoft Excel a cell can contain the following items:

· A number (such as decimal numbers, currency symbols punctuation marks)
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Picture 4 : Wrap Text

· Textual content (in which letters, and other signs are included).

· A formula, which is a mathematical equation.

· A function which is representing complex operation as a shortcut.

(iv) Creating a New Workbook in Excel : The following procedure is adopted to create a workbook : Click on 

Microsoft Office Excel 2010 and  Click on New, thereafter Click on Blank Workbook; Context Menu (Excel 

opens an empty workbook by default.)

(v) Save and Save as :

 By default Excel 2010 (*.xlsx )creates a new workbook in the 'unsaved format'. After making this 

workbook, this can be saved in the computer after using this. To save a newly created workbook, go 

to the File tab and select "Save As".

Picture 5 : Merge Cell
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(vi) Alignment group : If you'd like to realign text in a cell to enhance the visual presentation of your data, select 

the cells that have the text you want to be aligned. On the Home tab choose one of the following alignment 

options : (horizontal movement): To horizontally align text, pick Align Text Left, Center, Align text Right. To 

vertically align text, pick Top Align Middle Align or Bottom Align. 

 Wrapping: When you have a long line of text, part of the text might not be visible. To fix this without changing 

the column width, click Wrap Text. To center text spanning several columns or rows, click Merge & Center. 

(Picture 4 & 5)

(vii) Sort and Filters; Devices - Data collection of your worksheet in a particular order is basically called sorting. For 

example, the list of students of a school can be done in alphabetical order, class-wise or any other order in the 

order such as of birth.

 Sorting in alphabetical order : Select the column in the Excel, which you want to sort. On the Home tab, click 

on Sort and Filter Commands in the editing group. Select A to Z, Now the category (category) column will be 

organized in alphabetical order. 

 Sorting in small order : Select the cell in a column that you want to sort (column in which the number is 

entered). On the Home tab, click on Sort and Filter Commands in the editing group. Select from small to large; 

Now the information has been organized for a small number. You can also do reverse numerical order to make 

it smaller.

(viii) Create new worksheets and add rows and columns

 Worksheet - To add a new worksheet, select Insert / Worksheet in the menu bar.

 Row - To add a new row, select Insert / Row in the menu bar or highlight a row by clicking on the Row Level and 

right click in the mouse and select Insert.

 Columns - To add a new column, select Insert / Column in the menu bar or by clicking on the column level, 

highlight a column and right click with the mouse and select Insert.

(ix) Resizing Rows and Column 

 There are two ways to reduce or increase the size of daily and column :  A row can be resized by dragging on 

the bottom line of the cell level. Any column can be resized by dragging similar lines and keys or Select the 

format / row / height or format / column / width in the menu bar by entering the row or column level and 

enter the value of the row or column height or width.

(x)  Moving  and  coping  cells

 To move the cell : To cut the cell from one place to another,  select Edit / Cut in the menu bar or click the Cut 

button.

 To copy the cell : To copy a cell, select Edit / Copy in the menu bar or click the Cut button.

 Paste the cut or copied cell : To paste any cut or copied cell, select Edit / Paste in the menu bar or click the 

Paste button to paste the copied or copied cell.

 Drag  and  Drop : If you have to take a cell just a little bit away then the drag and drop method is much simpler 

to move something from its place. Click on it and drag the left button of the mouse  to the desired location.

(xi) Freeze Panes

 If your worksheet is too large and it has lots of rows and columns, due to which you do not see the title of any 

text matter if you scroll the worksheet, then you can freeze its pans. This process will come as follows.

 1. Click on the level of the row which is to be made visible

 2. Now select the window / freeze pans in the menu bar.

 3. To remove the freeze, select the window / unfreeze pans in the menu bar.

4. Features of MS Excel Spreadsheet

 1. Managing and using many types of data on a large scale.

 2. Data can be displayed through graph or chart.

 3. Data can be exported or imported to the spreadsheet through the software.
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 4. Data can be calculated at a fast pace.

 5. Once the formula is used, all calculations are processed. When the formula is changed it is 

  automatically formatted in the new cell.

 6. Spreadsheets can be used for different purposes, such as financial reporting, scientific research, tax 

calculation, budgeting, making business details etc.

 7. Spreadsheets have built-in analytical abilities.

5. Formulae and Functions

 Formulae are those equations that display calculations on values in your worksheet. In accounting these 

sources are used for different types of calculations. Microsoft Excel has the following basic formulas:

 l  Add (+)

 l  Deduct (-)

 l  Multiply (*)

 l  Division (/)

 To make a simple calculation you have a formula. Next you will have to write the calculation after the symbol 

(=) . A Formula can be applied with reference to cell instead of the actual value or number. To apply formula with cell 

reference, you can write cell coordinates and associated operations after the equal symbol (=). Syntax is used for this. 

Syntax refers to the formula being installed by the relation of the cell. For example if you wish to add two numbers that 

are in cell A1(5) and cell A2(80),you need to give the formulae = (A1+A2).The result will be displayed in the cell where 

the cursor is placed. Similarly, many operations can be done in a form cell reference. 

 To edit a formula, click on a cell, the corresponding formula will be displayed in the Formula box (formula box) 

and change the formula and press enter. Excel has some predetermined formulas that are called functions. The 

advantage of the function is that you will not have to type the formula in it, which will save a lot of time. The syntax of 

the Addition Function is shown below in the Picture 6.

Picture 6 : Sum Formula

If we wish to add the values available in cell B1, B2, B3. We can add the figures of all these cells with the 

function =SUM (B1, B2, B3). It is called a function and within the brackets the content is called the arguments. 

Similarly, many functions can be used to calculate in excel sheets. You can find the functions available in the Function 

Library. Important functions are illustrated by the picture 7 below:
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Picture 7 : Library Function

Application of Spreadsheet in Accounting
Spreadsheet can be used to calculate profit or loss of business. It is also used to prepare Balance Sheet. It is 

used to predict financial figures like profit, sales, cost, expenditure etc., in the coming years. This work can also be 

done through budget. It is a part of financial forecasting. The various applications of spreadsheet in accounting can be 

discussed as under :

1. Text and Number in Accounting : Text and numbers can be entered in the spreadsheet with the same cell. 

Number of text in cell can be formatted for different purposes. It is widely used in accounting. To type the text, select 

the cell where the text is to be typed. Excel software makes clear difference between text and numbers easily. 

Therefore, the process of entering the number is similar to the text. This can be understood by example. Locate the 

Cell pointer at cell A1 through mouse or arrow key .Move and type by mouse or arrow. Type XYZ Ltd. in cell A1, Rsin cell 

A2, and type in 2005 to 2000 in cell A3. The financial year is to be registered in cell A4 to F4. It can also be done by 

typing 2005 in A4 and 2004 in B4 , pick up the pointer to the right by selecting B4 .Drag the mouse to the right side till 

F4. Subsequently the sales data from cell A 5 and F5 can be filled up. This worksheet can be displayed in picture 8.

 A  B  C D  E F 

1 XYZ Ltd.      

2 (Rs.)      

3 2005 to 2000      

4 2005  2004  2003  2002  2001  2000  

5 50000  60000  30000  15000  10000  5000  

       

Picture 8 : Text & Number

2. Calculation of Expenses : The total expenses for a particular period can also be calculated .Quarterly 

spending details are given for a business. The total expenditure of each month is shown in cell E12, F12 and G12. 

Similarly, the total of a particular month of the three months of any one expenditure has been shown in cell I6 to I10 
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Picture 9 : Quarterly Expenses

3. Calculation of income : The income in business can also be calculated by the spreadsheet. This calculation can 

be done to annual, half yearly, quarterly etc. This is done by deducting expenditure from total revenue of the business. 

For this purpose subtract function will be used. Data can be transferred from Excel Spreadsheets to create any type of 

budget related to income or expenditure. Similarly, higher or lower expenditure and revenue can be pointed out in 

any month. The calculation of quarterly income is shown in the table. (Picture 10) 

Picture 10 : .Quarterly Income

.This is calculated by using SUM formula . For example the rent amount for three months will be=SUM(E6 : G6) which is 

executed in cell I6. Similarly, the total expenditure of the month of January has been calculated by the formula of 

SUM(E6 : E10). (Picture 9)

4. Preparation of Trading Account : Trading account is prepared to calculate gross profit of the business. 
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Picture 11 : Trading account

5. Preparation of Profit Loss Account : All Indirect expenses and indirect incomes are transferred to profit-

loss account. This final account is used to calculate net profit or net loss. If the credit side is more than the debit side 

then there is net profit situation and if the debit side is more than the credit side there is net loss situation. It can be  

explained through a spreadsheet. All the items from cell L 5 to L 7 belong to income. The  total is shown in L 19 by using 

the formula = SUM (L5 : L7). Cell G5 to G17 are items of expenses whose total sum is written in C16, after which the net      

profit is calculated by deducting C16 from L19 and projected in cell G18. The profit and loss account is represented by 

the following figure (Picture 12) : 

Picture 12 : Profit and loss Account

Direct expenses are debited in the trading account. In this account purchases and sales, opening stock and closing 

stock are the main entries. If the total of its credit side is more than the total of the debit side then there is  gross profit 

and if debit side is more than the total of credit side then gross loss is the result. It can be also made by spreadsheet. 

According to Figure 11, the cell J 6 and the J 7 show the sale and closing stock. The total of these cells is entered in  cell J 

23 by the formula SUM  (J6 : J7). All the direct expenses have been calculated in the second phase in the same manner 

and are written in B21. Subsequently, cell B21 is deducted from J23 by using the formula  = (J23 – B21), and that is 

placed at F21. (Picture 11)
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Picture 13 : Trial Balance

6. Trial Balance : It is a statement that represents the balances of ledger accounts.The total of debit side and 

credit side of trial balance must be equal. It is presented in the following figure. (picture 13)

7. Balance Sheet : The sum of assets and liabilities in the Balance Sheet should be equal. If we make changes in 

any type of financial data that is inserted into the cell, then its effect falls on other points calculated. The sum of assets 

is stated from cell  E4 to E9, which is shown in the cell E10. Its syntax is =SUM (E4:E9). (Picture 14)

Picture 14 : Balance Sheet

 After making the above mentioned accounts statements by Excel Spreadsheet, its effect will be displayed on 

the ultimate balance such as profit, loss etc., with immediate effect. This facility can be used for analysis of financial 

statements. Such details can be made in a very short time through a spreadsheet. As a result, accounting experts have 

the ability to make investment decisions etc.
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Picture 15 : Calculation of Tax

(ii)  Calculation of installment on loan : Monthly installment of a loan on which compound interest is charged is  

calculated with PMT formula ,which is  PMT (rate,  nper,  pv ,  [fv],  [type]), Where

 r = rate  of  interest 

 nper  =  Total  Payments  for  Loan

 pv = Principal  amount

 This calculation is available in the form of function also. This can be explained with the help of following 

example. A business took a loan of 200000 rupees at the rate of 6.75 percent for 30 years from the bank. The 

installment will be calculated with the following formula, =  PMT(B4/B5,  B3*B5,-B2). This is shown in the following 

table that represents the format of excel sheet. The amount payable per month is mentioned in cell B 6. (Picture 16)

 The analysis of financial statements can be used by accountants and 8. Other uses of Spreadsheets : 

investors, spreadsheets can be used for many other accounting and finance related activities. Some important 

financial functions have been mentioned in the following examples : 

(i)  Calculation of  tax : Spreadsheets can be used for predicting different types of taxes such as income tax, sales 

tax, custom duty, service tax etc., and their related sources. It has been explained by the following example. 

The sales figures are given in Column A, on which sales tax is charged at a rate of 10 percent. Which is 

calculated by the base formula: ( percentage of tax *amount of sales). According to the Excel formula, applied  

in the table given below. It has a syntax : =  (A1  *  0.5) the result is shown in Cell B1. (Picture 15)

 A B C 

 
Sales Tax 

 1 20 10 
 2 30 15 
 3 40 20 
 4 50 25 
 5 30 15 
 6 40 20 
 7 70 35 
 8 80 40 
 9 60 30 
 10 100 50 
  

A
 

B

1 Loan Data `

2 Principal Amount  200000

3 Loan Term 30

4 Intrest Rate 6.75%

5 Payment per Year
 

12

6 Installment(`)
 

1297.2

Picture 16 : Calculation of Installment loan

(iii)  Principal Amount : If you want to calculate the principal amount from the monthly installment, it can be 

calculated by PPMT function. The formula is =PPMT (rate/payment in a year, 1, years *payment in a year, 

Amount).

Example :   If the interest rate is 10 percent and the installment of  loan is payable on per month, the total 
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Picture 17 : Calculation of Monthly  Installment 

(iv) Interest included in installment : Similarly, in order to calculate the interest amount included in the installment, 

the use of IPMT function will be used. In the above example, it will be used by the following formula.

 = IPMT(10/12,1,5*12,100000). In the picture below cell numbers are used in place of original figures using 

the syntax calculation will be : IPMT (B1|B3, A7, B2*B3, B4) (Picture 18).

amount of loan is ̀ 100000 If the payment period is for 5 years, then the principal amount will be calculated from the 

formula, =  PPMT(10/12,  1,5*12,  100000) in this case, `1291.37 will be the principal amount. This is shown in the  

following picture. The cell numbers are used instead of original figures as syntax. (Picture 17)

Picture 18 : Calculation of Interest in Installment
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Picture 19 : Calculation of Interest

A B C  D  
1 Principal 

Amount
 

100000   

2 Rate
 

.08 %
   3 Year

 
5

   4

(v)  Ordinary interest on the capital or the loan : The interest rate on the respective capital or loan interest is 

calculated at a fixed rate on the principal amount. For this, the following formula is used :

 Principal amount *  Rate/100
 

For example, If the amount of ̀ 100000 has been taken for 5 years at 8 percent interest rate, interest will be 

payable. For calculating interest (`100000 *8/100) which is ` 8000  per annum. To calculate interest of 5 years 
5   (100000 * 8/100) will be done. According to the picture, the syntax for the calculation of interest of five years will be:

 = (B1/B2)*B3  or  B1*.08(Picture 19)

(vi)  Total income on Investment :  For calculating total income earned through interest on the basis of 

compounding, the compounded interest rate is multiplied by the principal amount. The amount calculated 

will be principal plus interest. For example, if ` 100 is invested at 8 percent, then after one year, the total 

amount will be ̀  108. This is indicated by the following table. (Picutre 20)

Picture 20 : Calculation of Income

If investment is for more than one year, the cursor will be dragged accordingly with one cell forward. 

Example: If a person has invested ̀ 100 for 5 years at 8% annual interest rate, ̀ 100 will be entered in A1, then the value 

of the investment will be calculated in A2, thereafter the cursor will be dragged till A6. The total income will be 

indicated by the following table. (Picture 21)

Picture 21 : Calculation of total income on Investment
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(vii)  Monthly Compound interest : In calculation of compounding interest, interest is calculated on the principal 

amount as well as on the interest amount accumulated at the end of specific period. Its original formula will 

be. Principal amount* (1+ Interest/Compounding period in year) ̂  (Compounding period *years)
  If an investment of `10,000 is done on 5% compounded annual interest for 10 years and the For Example :

th
interest is calculated on a monthly basis, then the amount receiveable at the end of 10  year will be Rs 16470. It is 

 
presented in the following table:(Picture 22)

Picture 22 : Calculation of monthly compound interest

If the calculation is done on quarterly basis then compounding will be done four times in a year. It is presented 

in the following table (Picture 23)

Picture 23 : Calculation of income on quarterly basis
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(vii)  Depreciation on Assets : Several methods are used to calculate depreciation of fixed assets of business. 

Calculation of depreciation through spreadsheet depends on the method used. It can be done through the 

construction of formula or with the help of excel function .The methods are discussed as under:

 (a)  Straight Line Method: According to this method the amount of depreciation remains fixed per year. 

This can be done by the function using syntax :  = SLN (cost, Salvage, life)

 For  Example : If the cost of a Fixed asset is Rs. 10,000 , where Salvage value is Rs 1,000. The asset will be used 

for 10 years. It will be determind according to the syntax calculation formula of depreciation as :

  = SLN (B2, B3, B4).The amount of depreciation will be ̀  9000 as shown in the table below. (Picture 24)

Picture 24 : Calculation of Depreciation based on the SLN formula

 (b)  Written down value method : According to this method the depreciation is calculated on the 

diminished value of the asset by using DB function, the syntax of which is:

  = DB (cost of asset, salvage, life, 1)

   The application of the above function in the previous example will be = DB (B4, B5, B6, A9). The 

amount of depreciation will be Rs.2,060. (Picture 25)

Picture 25: Calculation of Depreciation
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Financial forecasting
Excel spreadsheet is also used for financial forecasts. This is part of budget and project planning. It is also 

termed as financial statement analysis. For this, two types of financial statements typically can ben made in the 

spreadsheet.

Projected Profit Loss Account
This financial statement can be used to calculate future profits or losses. Through Spreadsheet data related to 

expenditure and income are entered in the cells. Any incremental or decremental change in the financial figures in a 

cell will immediately affect the final result in the form of profit or losses. For example, if the expense of salary is  

increased by ` 500, then the net profit will also automatically reduce to ` 500 or the net loss will increase by ` 500. 

Forecasts can be also done through percentage. The impact on profit or loss due to the increase in sales by 10% can be 

calculated.

Projected Balance Sheet
The position of assets and liabilities can be ascertained through projected balance sheet. It helps in 

estimating the financial requirement of the business for which planning can be done in advance. For example, if profit 

increases as 10 percent the immediate impact on capital, liabilities or assets can be calculated. Similarly, the future 

position of cash, movable assets, working capital and immovable assets can be also predicted.

Financial projections are helpful for a business organization if they wish to apply for any loan and advance 

from banks and financial institutions. According to the proposed plan future financial planning is done. The bank 

provides loans according to the predicted financial statements.

The usefulness and importance of Excel spreadsheet is revealed from the above discussion. A business 

organization can take its financial decisions intensely and accurately with the use of Excel spreadsheet.

Summary
l Excel is developed by Microsoft. It is a spreadsheet program created in many blocks, with the help of which 

you can keep and view various data in a tabular form. One of the special features of Excel is that, it also allows 

the user to perform different type of calculations. It can be used for both commercial and non-commercial 

purposes.

l Every file in Excel is known as workbook. There can be many worksheets under a workbook. A worksheet is 

deemed to be the structure containing columns and rows.

l Importance of Excel Spreadsheet: Used in Inventory management, calculation of working hours, billing 

format, financial accounting and analysis, maintaining customer details.

l Basic Functions and Formulae: Addition (+), Subtraction (-), Multiplication (*),Division( / ).These are used in 

various accounting applications.

l Spreadsheets are also used in financial forecasts, such as projected Profit and Loss account and Balance 

Sheet.

l Accounting and financial calculations can be done through spreadsheets using various functions and 

formulas.

Questions for Exercise
Multiple Choice Questions :

1 Which function will be used for calculating interest included in installment of a loan ?

  (a) PPMT (b) IPMT (c) FAPM       (d) None of above

2      What is the formula for adding the value of cell A1, A2 and A3 ?

 (a) SUM= (A1+A2+A3)    (b) SUM (A1,A2,A3)  

 (c) =SUM (A1:A3)   (d) None of above
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3 Components  of Excel Workbook are :

  (a) Workbook  (b) Worksheet  (c) Chart (d) Worksheet and Chart

4 Which command is used to make the title Rows and Column  static in case we wish to scroll the 

 spreadsheet ?

 (a) Freeze and Pan command (b) Unfreez Pan command  

 (c) Hold title command             (d) Merge command

 5  Where the values and Formulae are typed in window in Excel ?

  (a) Title Bar    (b) Short Screen menu command   (c) Formula Bar   (d) Standard Bar

6  Data and Formulae are copied through :

 (a) Cut, Copy ,Paste in edit menu  (b) Sort, screen, menu command  

 (c) Standard tool bar   (d) All of above

7  Which formula is incorrect?

 (a) = (10+15)    (b) = (B7*B1)   (c) (B7 + 14)  (d) 14+15 

8  Which function is used to calculate depreciation? 

 (a) SLN     (b) PRF    (c)  DVD  (d) LTF

9 What is the syntax for calculating depreciation on written down value method ?

 (a) =DB ( Cost,Salvage,life,1)  (b) = FB (Cost,25,1)   

 (c) =PFB (Cost,Salvage,life)            (d) None of above

10 Function for calculating principal amount in installment will be :

 (a) RPT    (b) PMT    (c) PPMT  (d) IPMT

Very Short Answers Questions :

1.  What is a Spreadsheet?

2.  What is the syntax of the PPMT function ?

3.  What is the procedure to save a file in a Spreadsheet?

4.  What is a Cell and Row ?

5. The life of machine is 10 years, with cost of Rs. 500000. Describe the process of calculating depreciation 

(original cost basis) on the spreadsheet.

6.  Explain the calculation of compound interest by example.

Short answer type questions :

1.  Explain the basic elements of Microsoft Excel

2.  Describe the key points of Spreadsheets.

3.  Explain the importance of spreadsheets in Accounting.

4.  Explain the difference between spreadsheet and workbook.

5.  Explain the following FUNCTIONS with examples:

  (i)   PMT

  (ii)   SUM

  (iii)  IPMT 

6.  Mahesh borrowed a loan of `500000 for buying a car at 5 percent interest rate. The loan is to be paid on 

quarterly basis in 10 years. Calculate the quarterly installment in the spreadsheet.

Answers of Multiple Choice Questions

1 2 3 4 5 6 7 8 9 10

b c d a c d d a a c  Answer

Question No.
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